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Chapter 1 - General Sheets

1.1 Plan Sheet Requirements

These are the general requirements and standards that 
apply to all sheets in the plan set.

1.1.1 Reference and Drawing 
Files

CDOT has specified two types of CADD files in the 
development of plan sets, Drawing and Reference 
Files. Understanding the differences these two types 
of files, and what belongs in each type of file, is 
crucial to producing project plan sets that meet 
CDOT standards.

Reference files contain all the design information 
(i.e. line work and detailed drawing) for the entire 
project and are separated by discipline (for example, 
JPC#DES, JPC#ROW, JPC#BRDG, JPC#TRAF). 
These Files are typically located in 
JPC#\[Discipline]\Drawings\Reference_Files\. 
Reference files should never contain plan notes or a 
border.

Drawing files are used for organizing the design 
information into printable plan sets. Generally the 
Drawing files reference one or more Reference files 
and add a border, callouts, labels, notes, and title. 
These Files are typically located in 
JPC#\[Discipline]\Drawings\. Design line work and 
details should not be done directly inside of the 
Drawing file.

1.1.2 Generating Plan Sheets

The first step in creating plan sheets is to cut sheets. 
Cutting sheets means creating individual 
MicroStation drawings that follow an alignment at a 
specific scale and consistent interval. 

For small projects with only a few plan sheets, sheets 
that are generated from the Project Creation Utility 
can be used to cut sheets manually.

For large projects, the most efficient way to cut 
sheets is to use the “Plan & Profile Generator” tool in 
InRoads. This tool automatically generates plan 
sheets. It will create the scaled sheet view, create 
match lines, reference files, clip boundaries, and 
north arrow.

Preferences have been set up for the  “Plan and 
Profile Generator” to match the various standard 
scales used by CDOT. The preferences make many 
of the dialog box settings automatically, allowing the 
user to focus on the data rather than dialog box 
toggles.

1.1.3 Reference Files

When referencing files into the Drawing files, 
remember the following general guidelines.

 Attach design files with the orientation “coinci-
dent – world” and at a scale of 1:1. Do not 
move, scale, or rotate a design file.

 The proper scale and orientation for plotting can 
be achieved by first rotating the view and then 
attaching the border file using the “Top” view at 
the desired scale. The border attachment can then 
be moved to the correct location. If the design 
file is attached coincidently, features in the sheet 
files maintain their proper coordinates.

The only exceptions to these guidelines are details 
and typical sections. For these drawing, all 
linework, notes, labeling, and borders are done in 
the Drawing file. See “Typical Sections” and 
“Project Details” for more information.

There are a few exceptions to this rule. For example 
detail sheets with multiple attachments or sheets 
that combine plan and profile views. For plan and 
profile sheets, the recommended approach is to 
attach the plan view coincidently and then move the 
profile view into the right location by attaching it as 
a saved view.
Colorado Department of Transportation  3-3
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1.1.4 General Drafting

 Use text styles that are provided in the CDOT 
workspace and proper levels with bylevel sym-
bology. Text styles with the word “title” in the 
name are to be used for the Title sheets and detail 
titles. 

 Use dimension styles that are provided in the 
CDOT workspace and proper levels with bylevel 
symbology.

 Organize callouts based on whether they are left 
or right of the alignment.

 North arrow and barscale go in the top half of the 
sheet in an open spot of the drawing sheet.

 Sheet borders: Sheet border information that is 
constant throughout all sheets for a project is 
edited in a reference file. The sheet border infor-
mation in a reference file is actually a scaled cell 
containing a series of text elements or tags that is 
placed in each sheet file. Title block information 
is changed by using the “edit text” or “edit tags” 
icons. Sheet border cells can also be placed 
directly into each Drawing file.

 Resident Engineer cell goes on every sheet unless 
stated otherwise

1.1.5 Guidelines For Callouts

There are several ways to label in MicroStation. Here 
are a few options.

 The preferred method is to use the “Place Note” 
tool on the “Text” toolbar in MicroStation. When 
using this method, be sure to set the text and 
dimension styles prior to placing the note. The 
advantage of this method is that the text, leaders, 
and arrows are placed as a group and can be eas-
ily moved, adjusted, and edited.

 Use the InRoads “Drafting” tools to place intelli-
gent annotation notes on features and geometry in 
plan, profile, and cross section views as well as at 
the intersection of two alignments.

Using the CDOT text and dimension styles 
maintains a consistent “look and feel” throughout 
the plan set.

Using the title block cell insures that the title blocks 
for all sheets look the same (text styles, dimension 
styles, levels, layout, etc.).
3-4 Colorado Department of Transportation
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1.2 Title Sheets

There are four primary title sheets.

 Project Title Sheet

 ROW Title Sheet

 ROW Project Control Diagram (PCD) Title Sheet

 ROW Land Survey Control Diagram (LSCD) 
Title Sheet

1.2.1 Project Title Sheet

 Clearly label the Begin and End Project stations 
and mile posts on Project Location Map

 Call out all structure numbers within the project 
limits

 North arrow in the top left corner of the Project 
Location Map

 Identify the project as a Federal aid or State 
funded project

 Fill out Project lengths and Design Data

 Bar scale located below the Project Location Map 
title

 Fill out the sheet border information

 If possible, the Index of Sheets should be placed 
on the Title Sheet. If the Index of Sheets is too 
large to fit conveniently on the Title Sheet, then it 
should be put on the next sheet in the plan set.

1.2.2 ROW Title Sheet

 Clearly label the ROW Begin and End Project 
stations and mile posts on Project Location Map

 Clearly label the Construction Begin and End 
Project stations and mile posts on Project Loca-
tion Map

 North arrow in the bottom right corner of the 
Project Location Map

 Identify the project as a Federal aid or State 
funded project

 Fill out ROW and Construction Project lengths

 Bar scale located below the Project Location Map 
title

 Fill out the sheet border information

 Insert ROW Manager cell

 Edit the Index of Sheets for each subset

1.2.3 ROW PCD Title Sheet

 Clearly label the ROW Begin and End Project 
stations and mile posts on Project Location Map

 Clearly label the Construction Begin and End 
Project stations and mile posts on Project Loca-
tion Map

 North arrow in the bottom right corner of the 
Project Location Map

 Bar scale located below the Project Location Map 
title

 Fill out the sheet border information

 Insert ROW Manager cell

 Edit the Index of Sheets for the PCD subset

1.2.4 ROW LSCD Title Sheet

 Clearly label the ROW Begin and End Project 
stations and mile posts on Project Location Map

 Clearly label the Construction Begin and End 
Project stations and mile posts on Project Loca-
tion Map

 North arrow in the bottom right corner of the 
Project Location Map

 Bar scale located below the Project Location Map 
title

 Fill out the sheet border information

 Insert ROW Manager cell

 Edit the Index of Sheets for the LSCD subset
3-6 Colorado Department of Transportation
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1.2.5 Reference Files

The following file(s) should be referenced into the 
Title sheet, moved, and clipped to the Project 
Location Map limits.

File Name Location

[CountyName].dgn JPC#\Design\Drawings\ 
reference_files\
Colorado Department of Transportation  3-7
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1.3 Index of Sheets

The Index of Sheets is an optional sheet if the Index 
of Sheets is too large to fit conveniently on the Title 
Sheet.

1.3.1 Index of Sheet Checklist

 Fill out the sheet border information

 Attach project specific Index of Sheets Excel 
Spreadsheet

1.3.2 Linking Microsoft Excel 
Files into MicroStation

The Index of Sheets uses an Excel spreadsheet to 
organize and display the plan set drawing order.

After creating the drawing file, link the Excel 
spreadsheet by taking the following steps:

 Highlight the area of the spreadsheet to be linked 
and copy it to the clipboard

 In MicroStation select Edit>Paste Special

 In the “Paste Special” dialog box choose “Linked 
Microsoft Office Excel Worksheet”

 In the “Paste OLE” dialog box. Change the “Paste 
as” to “Link”, the “Method” to “By Size”, and the 
“Scale” to ”8.5” to match the .07” ENG-100 Text 
Style.

The link will display with hatching which indicates 
that the Excel file containing the linked data is 
currently open. If you close out of your Excel file, the 
hatching will go away.

1.3.3 Updating Linking 
Microsoft Excel Files

Linked Excel spreadsheets update automatically 
when the MicroStation file is opened or when you 
close out of Excel after editing.

For more information on linking Microsoft Excel files 
review this workflow, CDOT Linking Excel 
Documents to MicroStation

MicroStation Placement Methods:

Linked Microsoft Office Excel Worksheet 
(Preferred) - Requires a saved excel file and can be 
edited by opening the spreadsheet in Excel or 
double clicking the spreadsheet in MicroStation. 
This method will automatically update 
MicroStation after editing.

Embedded Microsoft Office Excel Worksheet - The 
spreadsheet is placed directly into MicroStation. 
Double click the spreadsheet in MicroStation to edit 
in Excel as a temporary worksheet.

Picture of Microsoft Office Excel Worksheet - 
Static graphic of the spreadsheet. This method can 
not be edited or updated.

Excel places a little green triangle in the corner of 
cells that have formulas with errors. If the 
MicroStation file is closed while a link is still active 
these triangles become part of the graphic and will 
appear when the summary sheets are plotted. To 
avoid this, close all active links in Excel before 
closing MicroStation.

To turn off these graphics in Excel, Open the Excel 
Options, Click on Formulas and toggle off Enable 
background error checking.
3-12 Colorado Department of Transportation
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1.4 Standard Plans List

The Standard Plans List is prepared by the Colorado 
Department of Transportation for the use on CDOT 
construction projects. Others who use the CDOT 
Standard Plans do so at their own risk.

Standard Plans that are applicable to a specific project 
will be identified on the project plans and will not be 
physically attached to those plans. The designer who 
specifies any of these Standard Plans for a specific 
project accepts the responsibility of determining their 
applicability.

Standard Plans adopted or revised subsequent to the 
adoption of this book will be listed on the index of the 
project plans and will be physically included in the 
plans.

1.4.1 Standard Plans List 
Sheet Checklist

 Download the latest Standard Plans List from 
CDOT’s website:

http://www.coloradodot.info/business/designsupport/
standard-plans/2006-m-standards 

 Save the dgn download to, JPC#\Design\Draw-
ings\ replacing the existing file

 Open file, JPC#\Design\Drawings\ 
JPC#DES_StdPlanList.dgn

 Fill in the box(es) for all applicable Standard 
Plans to be used in the project

1.4.2 Reference Files

The following file(s) should be referenced into the 
Standard Plans List drawing.

File Name Location

M&S Standard 
Plans List Index.dgn

JPC#\Design\Drawings\ 
3-14 Colorado Department of Transportation
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1.5 General Notes

The General Notes drawing contains project specific 
information about the plan set. The notes provide 
contractors an understanding of the designers 
intentions and CDOT requirements and processes.

1.5.1 General Notes Checklist

 Fill out the sheet border information

 Link the project specific General Notes Word doc 
file

1.5.2 Linking Microsoft Word 
Files into MicroStation

The General Notes drawing uses a Word document to 
display the project specific notes.

After creating the drawing file, link the Word 
document by taking the following steps:

 Highlight the area of the document to be linked 
and copy it to the clipboard

 In MicroStation select Edit>Paste Special

 In the “Paste Special” dialog box choose “Linked 
Microsoft Office Word Document”

 In the “Paste OLE” dialog box. Change the “Paste 
as” to “Link”, the “Method” to “By Corners”. 
Then tentative and select the guide line in the 
drawing file to match the .07” ENG-100 Text 
Style.

The link will display with hatching which indicates 
that the Word file containing the linked data is 
currently open. If you close out of your Word file, the 
hatching will go away.

1.5.3 Updating Linking 
Microsoft Word Files

Linked Word documents update automatically when 
the MicroStation file is opened or when you close out 
of Word after editing.

For more information on linking Microsoft Word files 
review this workflow, CDOT Linking Word 
Documents to MicroStation

MicroStation Placement Methods:

Linked Microsoft Office Word Document 
(Preferred) - Requires a saved Word file and can be 
edited by opening the document in Word or double 
clicking the document in MicroStation. This 
method will automatically update MicroStation 
when opened or after editing.

Embedded Microsoft Office Word Document - The 
document is placed directly into MicroStation. 
Double click the document in MicroStation to edit 
in Word as a temporary document.

Picture of Microsoft Office Word Document - 
Static graphic of the document. This method can 
not be edited or updated.
3-16 Colorado Department of Transportation
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1.6 Typical Sections

Typical Sections show the proposed typical section 
for complete reconstruction, ramps, widening and 
overlay projects.

Typical sections are placed directly in the drawing file 
within the sheet border and don’t require referencing. 

For more information refer to the CDOT Roadway 
Design Guide, Chapter 4 Cross Section Elements.

1.6.1 Roadway Typical 
Sections

 Provide as least one existing section for each 
project. Place existing typical sections up front 
prior to the proposed sections and clearly title it 
Existing Section

 Provide a typical section showing how the new 
pavement section ties into the existing pavement. 
Clearly title this typical section as Approach to 
Project

 Each typical section has the station limits identi-
fied and the name of the road identified in the 
sheet border

 Label and dimension (in inches) all parts of the 
pavement section (surface course - all lifts, base 
course, sub-base, etc.)

 Label the location of the control line and profile 
grade

 Label lane and shoulder widths

1.6.2 Bridge Typical Sections

 Label the location of the control line and profile 
grade

 Label lane and shoulder widths

 Label surface course in inches

1.6.3 Typical Section Program

CDOT has developed a custom program to help 
generate roadway typical sections. The program, 
TypicalSection.exe, can be found within the 
CDOT workspace, Workspace-CDOT_XM 
\Standards-Global\MicroStation\exes.

This program is not intended to provide complete 
typical sections, but to provide a base output that can 
easily be modified to fulfill any project sections that 
are required.

For more information on the CDOT workflow using 
the typical section program, click the help icon in the 
TypicalSection.exe program.

The main purpose of the existing sections is to show 
the existing pavement section with a typical width. 
As such, most projects will require only one 
existing section. However, if there is a substantial 
change in the existing pavement section (i.e., 
concrete vs. asphalt, substantial variations in 
thickness) additional pavement sections should be 
provided.

Approach to Project sections are often required to 
transition the new crown into the existing crown. 
They also can be used to show a different pavement 
section because they may be temporary.

Be sure to verify that the pavement section shown 
in the typical sections agrees with the approved 
pavement design.
3-18 Colorado Department of Transportation
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CADD Manual Section 3: Plan Production
Chapter 1: General Sheets
1.6.4 Guidelines on the 
Number of Typical 
Sections

The number of typical sections required for a project 
varies, depending on a variety of factors. It is 
essential that enough typical sections be included to 
allow a contractor to understand how the road is built. 
On the other hand, it is possible to show so many 
typical sections that the plan set is confusing and 
difficult to follow. This is especially true if a typical 
section is developed for “every situation” on 
complex, urban projects.

The following guidelines have been developed to help 
the designer determine the appropriate number of 
typical sections required for the project.

DO PROVIDE SEPARATE TYPICAL 
SECTIONS:

 For each alignment (mainline, ramps, frontage 
roads, etc.)

 For different lane configurations

 When the pavement section changes

 When the improvements change significantly 
(i.e., one section has curb and gutter with side-
walk versus another section without curb and gut-
ter)

 When the cross section has major differences 
(i.e., depressed median versus raised median)

 For structures

DON’T:

 Show a typical section where everything is vary-
ing (for example, at intersection approaches or 
transition sections)

 Make a new typical section for minor changes in 
cross section that occur for a very short distance 
(i.e., 4’ sidewalk versus 6’ sidewalk for 100 feet)

Note: Typical sections for bridges can be omitted 
from the roadway plans if they are included with the 
structure plans.
Colorado Department of Transportation  3-19
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Section 3: Plan Production CADD Manual
Chapter 1: General Sheets
1.7 Summary of Approximate 
Quantities (SAQ)

The SAQ sheets is required to summarize all pay 
items called out in the drawing sheets. SAQ sheets are 
generated by Sumgraph to obtain quantities for the 
engineer’s estimate.

1.7.1 SAQ Workflow

For more information generating SAQ’s out of 
Sumgraph, please review this workflow; CDOT SAQ 
Sheets.
3-22 Colorado Department of Transportation
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Section 3: Plan Production CADD Manual
Chapter 1: General Sheets
1.8 Project Details

Project detail sheets contain all detail drawings that 
are project specific necessary to build the project.

Details are broken out into two types; true scale and 
Not to Scale (NTS). True scale details are drawn and 
placed in the sheet at  a 1 to 1 scale. 

NTS details are drawn to with an exaggerated scale to 
better illustrate the subject of the detail.

1.8.1 Project Detail Sheet 
Checklist

 Details are drawn at true scale  can be dimen-
sioned using the MicroStation dimensioning 
tools. For NTS details, dimensions must be con-
structed manually.

  Draw all of the details in one file and keep them 
organized.

  Keep detail sheets organized by category in the 
plan set. For example, keep all of the roadway 
details sheets together, all of the drainage detail 
sheets together, etc.

1.8.2 Reference Files

Drawing with the details drawn in a separate model 
from the sheet border are referenced to itself, using 
the model containing the detail for the reference file 
and the model containing the sheet border as the 
master file.

Standard details that are found in the M&S 
Standards do not need to be added to the project 
details. The M&S Standards are automatically 
added to the project plan set at reprographics.

Drawing at full scale makes dimensioning easier  
and helps keep dimensioning accurate.

SUGGESTION 1: It will make things easier if the 
details are organized inside of boxes. These boxes 
should be placed on a nonprint level and be the 
same size as the inside drawing area of a scaled 
sheet file border.

SUGGESTION 2: For projects with a lot of details, 
it is helpful to split the details into more than one 
file organized by category. This allows multiple 
users to work on the details at one time.
3-24 Colorado Department of Transportation
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CADD Manual Section 3: Plan Production
Chapter 1: General Sheets
1.9 Removal Plan Sheets

Removal plans are used to identify which roadway 
assets will be removed as part of the construction 
process and locate where these assets occur. 

1.9.1 Plan Sheet Checklist

 Fill out the sheet border information.

 Add the North Arrow and Bar Scale to each sheet 
in an open area (in a corner is preferred).

 Label existing and proposed right-of-way.

 Label alignment names.

 Label street nd road names.

 Add notes for items to be removed or reset. These 
should contain a description of the item, Station 
(start and stop stations for linear items), and the 
quantity of the removal/reset.

 Add a legend of any patterned areas.

1.9.2 Reference Files

The following file(s) should be referenced into 
each Removal Plan Sheet.

File Name Location

JPC#DES_Model JPC#\Design\Drawings\ 
Reference_Files

JPC#SURV_Topo#
#Scale##

JPC#\ROW_Survey\ 
Drawings\Reference_ 
Files
Colorado Department of Transportation  3-27
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Chapter 2 - Design Sheets

2.1 Plan and Profile Sheet

Plan and Profile sheets  combine the properties of the 
plan sheet and the profile sheet described previously.

The plan occupies the upper half of the sheet and the 
profile takes up the bottom half. If superelevation 
data is displayed, it as placed at the very bottom of 
the sheet, reducing the area for both the plan and 
profile to accommodate the additional data.

2.1.1 Plan and Profile Sheet 
Checklist

 Clearly label horizontal alignment. This 
includes: stationing, bearing, PC, PT, crossings 
with other alignments, and curve data (Δ, R, T, L, 
& PI station/coordinates).

  Include street names on mainline and all cross 
streets.

 Call out all items of work for the new roadway.

 Label all structures. This includes bridges, box 
culverts, and retaining walls. 

 Show cut & fill lines for mainline, ramps, and 
any side streets.

 Show driveway approach lengths, widths, and 
pavement type.

 Label tie-in with existing pavement

 Label the start and stop station of all pavement 
transitions.

 Show the alignment name on each profile sheet.

 The proposed vertical alignment is annotated.

 Station limits for the sheet and the match line sta-
tions must match EXACTLY.

 Show existing and proposed elevations on the 
bottom axis.

 Identify and label names of major intersected 
streets, railroads, grade separation structures, 
culverts, streams, and other control lines.

 Use Inroads preferences to create profile sheets 
that conform to Department standards.

2.1.2 Profile Sheet Checklist 
(Superelevation)

 Show superelevation at the bottom of the plan 
and profile sheet.

 Label Station and rates at all transition points

2.1.3 How To Call Out Items

 A station & offset callout should be provided at 
the beginning and ending of each item and at 
match lines. Pavement transitions may be called 
out where feasible.

 Call out items to the nearest 0.01 of a foot.

 Call out driveways to the center of driveways at 
lip of curb.

 Call out pedestrian ramps to the center of ramps 
at top back of curb.

SUGGESTION: Using Inroads “Plan and
Profile Generator” is an easy way to generate
the plan and profile sheets.
Colorado Department of Transportation  3-29



Section 3: Plan Production CADD Manual
Chapter 2: Design Sheets
2.1.4 Reference Files

The following file(s) should be referenced into 
each Plan and Profile Sheet.

File Name Location

JPC#DES_Model JPC#\Design\Drawings\R
eference_Files

JPC#DES_Prof JPC#\Design\Drawings\ 
Reference_Files

JPC#BRDG_Model JPC#\Bridge\Drawings\R
eference_Files

JPC#HYDR_Model JPC#\Hydraulics\Drawing
s\Reference_Files

JPC#LAND_ENVI_
Model

JPC#\Landscape_Enviro
nmental\Drawings\Refere
nce_Files

JPC#SURV_Topo#
#Scale##

JPC#\ROW_Survey\Draw
ings\Reference_Files

JPC#TRAF_Model JPC#\Traffic_ITS\Drawin
gs\Reference_Files

JPC#UTIL_Model JPC#\Utilities\Drawings\R
eference_Files
3-30 Colorado Department of Transportation
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Section 3: Plan Production CADD Manual
Chapter 2: Design Sheets
2.2 Plan Sheets

Roadway plan sheets contain information regarding 
alignments and identify all new roadway items for the 
project. Plan sheets are used when the area described 
is too big or contains too much data to fit in the plan 
area of a plan and profile sheet. 

2.2.1 Plan Sheet Checklist

 Clearly label horizontal alignment. This includes: 
stationing, bearing, PC, PT, crossings with other 
alignments, and curve data (Δ, R, T, L, & PI sta-
tion/coordinates).

  Include street names on mainline and all cross 
streets.

 Call out all items of work for the new roadway.

 Label all structures. This includes bridges, box 
culverts, and retaining walls. 

 Show cut & fill lines for mainline, ramps, and any 
side streets.

 Show driveway approach lengths, widths, and 
pavement type.

 Label tie-in with existing pavement

 Label the start and stop station of all pavement 
transitions.

2.2.2 How To Call Out Items

 A station & offset callout should be provided at 
the beginning and ending of each item and at 
match lines. Pavement transitions may be called 
out where feasible.

 Call out items to the nearest 0.01 of a foot.

 Call out driveways to the center of driveways at 
lip of curb.

 Call out pedestrian ramps to the center of ramps 
at top back of curb.

2.2.3 Reference Files

The following file(s) should be referenced into 
each Plan Sheet.

File Name Location

JPC#DES_Model JPC#\Design\Drawings\R
eference_Files

JPC#BRDG_Model JPC#\Bridge\Drawings\R
eference_Files

JPC#HYDR_Model JPC#\Hydraulics\Drawing
s\Reference_Files

JPC#LAND_ENVI_
Model

JPC#\Landscape_Enviro
nmental\Drawings\Refere
nce_Files

JPC#SURV_Topo#
#Scale##

JPC#\ROW_Survey\Dra
wings\Reference_Files

JPC#TRAF_Model JPC#\Traffic_ITS\Drawin
gs\Reference_Files

JPC#UTIL_Model JPC#\Utilities\Drawings\
Reference_Files
3-32 Colorado Department of Transportation
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Section 3: Plan Production CADD Manual
Chapter 2: Design Sheets
2.3 Profile Sheets

Roadway Profile Sheets are used to show the 
existing ground and proposed vertical alignment. 
Each profile sheet may contain one or two profile 
grids, depending on the height of the grid being 
used.
Profile sheets can also be used to display the 
proposed superelevation.

2.3.1 Profile Sheet Checklist

 Show the alignment name on each profile sheet.

 The proposed vertical alignment is annotated.

 Station limits for the sheet and the match line sta-
tions must match EXACTLY.

 Show existing and proposed elevations on the 
bottom axis.

 Identify and label names of major intersected 
streets, railroads, grade separation structures, cul-
verts, streams, and other control lines.

 Use Inroads preferences to create profile sheets 
that conform to Department standards.

2.3.2 Profile Sheet Checklist 
(Superelevation)

 Show superelevation at the bottom of the profile 
sheet.

 Label Station and rates at all transition points

2.3.3 Reference Files

The following file(s) should be referenced into

each Profile Sheet.

SUGGESTION: Using Inroads “Plan and
Profile Generator” is an easy way to generate
the profile sheets.

File Name Location

JPC#DES_Prof JPC#\Design\Drawings\ 
Reference_Files
3-34 Colorado Department of Transportation
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Section 3: Plan Production CADD Manual
Chapter 2: Design Sheets
2.4 Phasing Plan Sheet

Phasing Plans provide a sequence of construction and 
a traffic control plan for the project. The Phasing Plan 
describes the most efficient methods of moving traffic 
and construction materials through the work zone.

2.4.1 Phasing Plan Sheet 
Checklist

 Provide a Phasing Plan Legend that describes the 
various symbols and patterns used in the plan.

 Add matchline and data to the beginning and end 
of each sheet as needed.

 Place the north arrow and bar scale in an open 
corner of the sheet.

 Add construction notes as needed to further 
define items indicated in the phasing plan refer-
ence files.

 Add dimensions as needed to further define the 
location of materials or areas of work.

2.4.2 Rererence Files

The following file(s) should be referenced into

each Phasing Plan Sheet.

File Name Location

JPC#DES_Prof JPC#\Design\Drawings\ 
Reference_Files
3-36 Colorado Department of Transportation
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Section 3: Plan Production CADD Manual
Chapter 2: Design Sheets
2.5 Grading Plan Sheet

Grading Plans are used to provide additional 
information about the roadway design in areas where 
cross sections may not adequately express the 
designers intent. 

For the Grading Plan, existing and proposed contours 
are used to illustrate the designer’s layout.

2.5.1 Grading Plan Sheet 
Checklist

 Clearly label horizontal alignment.  

 Include street names on mainline and all cross 
streets.

 Display contours of the existing surface.

 Display contours of the design surface

 Add matchline and data to the beginning and end 
of each sheet as needed.

 Place the north arrow and bar scale in an open 
corner of the sheet.

 Label Right-of-Way lines.

2.5.2 Reference Files

The following file(s) should be referenced into

each Grading Plan Sheet.

File Name Location

JPC#DES_Model JPC#\Design\Drawings\ 
Reference_Files

JPC#SURV_TopoC
ontour##Scale##

JPC#\ROW_Survey\Draw
ings\Reference_Files
3-38 Colorado Department of Transportation
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Section 3: Plan Production CADD Manual
Chapter 2: Design Sheets
2.6 Cross Section Sheets

A set of cross sections is a group of sectional views of 
the road prism taken at a specified interval along an 
alignment. The set is used for staking during 
construction and for computing volumes during the 
design process.

2.6.1 Plan Sheet Checklist

 Fill out the sheet border information.

 Add data for end areas and volumes for each 
cross section.

 Add sheet totals for volumes.

 Draw drainage structures on cross sections as 
needed.

 Draw accesses on cross sections as needed.

 Label the PGL elevation on each cross section.

 Label the existing ground elevation at the center-
line for each cross section.

2.6.2 Reference Files

The following file(s) should be referenced into 
each Cross Section Sheet.

InRoads can be used to automate the process of 
annotating End-Area volumes.

File Name Location

JPC#DES_Cross_ 
Sections

JPC#\Design\Drawings\ 
Cross_Sections
3-40 Colorado Department of Transportation
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Section 3: Plan Production CADD Manual
Chapter 2: Design Sheets
3-42 Colorado Department of Transportation



Chapter 3 - Bridge Sheets

3.1 General Information Sheet

The general information sheet contains notes, 
specifications, and other data that pertains to the 
structural subset. Some notes may apply to the 
project as a whole. This includes an index of 
drawings and bridge description.  See Bridge 
Detailing Manual for additional information.

3.1.1 General Information 
Sheet Checklist

 Fill in the title block information.

 Place the general notes starting in the upper left 
corner of the sheet.

 Place the design data next to the general notes.

 Place the Index of Drawings in the upper right 
corner.

 Place other information, such as the bridge 
description and symbol descriptions, in an open 
area.

Text for the notes can be typed in Word, then cut 
and pasted into the MicroStation text editor. This 
way data that is the same on multiple sheets only 
has to be typed once. 
Colorado Department of Transportation  3-43
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CADD Manual Section 3: Plan Production
Chapter 3: Bridge Sheets
3.2 General Layout Sheet

The general layout sheet generally shows a plan and 
longitudinal section of the bridge structure. Existing 
topo is shown to provide a point of reference.

The Plan and Section drawings are produced at 1:1 
scale in the CDOT Default model. These are then 
referenced into the Sheet model (contained in the 
same dgn file) for dimensioning and printing.

If other disciplines will be referencing the layout 
linework, the linework should be provided in a bridge 
model in the reference_files subdirectory.  The CDOT 
Default model should be renamed to a logical such as 
"structure #" linework.  The majority of linework for 
a bridge or structure should be located in the main 
model and referenced to the individual details sheets.  
This is done to minimize the number of times items 
are drawn and copied.  Conflicts are easier to identify 
if all components of the bridge are in one linework 
model.  Linework for Elevations,  sections, etc. may 
be included in the main model or in the individual 
detail sheets.

See Bridge Detailing Manual for additional 
information.

3.2.1 General Layout Sheet 
Checklist

 Fill in the title block information.

 Fill in the Initials Table.

 Attach the General Layout and detail drawings as 
references to the Sheet model.

 Add titles for each detail in the Sheet model.

 Dimension each detail as needed in the Sheet 
model.

 Indicate the flow direction of water courses.

 Label horizontal alignments in the plan view.

 Place a north arrow in an open area of the plan 
view.

3.2.2 Reference Files

The following file(s) should be referenced into

each General Layout Sheet.

All models should be a "design" type model and not 
a "Sheet" type.  As of this version, there are still 
issues with "sheet" type models that sometimes 
produces corruption and printing problems.

Using Saved Views of the drawings in the CDOT 
Default model will make it easier to attach those 
drawings as reference files.

File Name Location

JPC#BRDG_Model JPC#\Bridge\Drawings\R
eference_Files

JPC#SURV_Topo#
#Scale##

JPC#\ROW_Survey\Draw
ings\Reference_Files

JPC#SURV_ 
TopoContour## 
Scale##

JPC#\ROW_Survey\Draw
ings\Reference_Files
Colorado Department of Transportation  3-45
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CADD Manual Section 3: Plan Production
Chapter 3: Bridge Sheets
3.3 Caisson/Piling Layout 
Sheet

The Caisson/Piling Layout sheet gives location, 
design, and sequence of construction information for 
substructure foundations including piles and caissons.

The linework for the Caisson/Piling Layout and Detail 
drawings are produced at 1:1 scale in the Bridge 
Model. These are then referenced into the Sheet 
model for dimensioning and printing.

See Bridge Detailing Manual for additional 
information.

3.3.1 Caisson Layout Sheet 
Checklist

 Fill in the title bar information.

 Fill in the Initials Table.

 Attach the Caisson Layout and detail drawings as 
references to the Sheet model.

 Label and dimension the details in the Sheet 
model.

 Place Notes and data tables in an open area of the 
Sheet model.

3.3.2 Reference Files

The following file(s) should be referenced into

each Caisson Layout Sheet.

Using Saved Views of the drawings in the CDOT 
Default model will make it easier to attach those 
drawings as reference files.

File Name Location

JPC#BRDG_Model JPC#\Bridge\Drawings\R
eference_Files
Colorado Department of Transportation  3-47
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CADD Manual Section 3: Plan Production
Chapter 3: Bridge Sheets
3.4 Abutment Sheet

The Abutment sheet contains plan and elevation 
details of the bridge abutment.

The abutment details are produced at 1:1 scale in the 
Bridge Model. These are then referenced into the 
Sheet model for dimensioning and printing.

See Bridge Detailing Manual for additional 
information.

3.4.1 Abutment Sheet 
Checklist

 Fill in the title bar information.

 Fill in the Initials Table.

 Attach the Plan and Elevation drawings as refer-
ences to the Sheet model.

 Label and dimension the details in the Sheet 
model.

 Place notes in an open area of the Sheet model.

3.4.2 Reference Files

The following file(s) should be referenced into

each Abutment Sheet.

Using Saved Views of the drawings in the CDOT 
Default model will make it easier to attach those 
drawings as reference files.

File Name Location

JPC#BRDG_Model JPC#\Bridge\Drawings\R
eference_Files
Colorado Department of Transportation  3-49
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CADD Manual Section 3: Plan Production
Chapter 3: Bridge Sheets
3.5 Wingwall Detail Sheet

The Wingwall Detail sheet provides a Plan, Elevation, 
and Section view to define the construction of the 
wingwall.

The plan view linework for detail drawings are 
produced at 1:1 scale in the Bridge Model. Elevations 
and sections may be produced in the individual detail 
sheet linework model. These are then referenced into 
the Sheet model (contained in the same dgn file) for 
dimensioning and printing.

See Bridge Detailing Manual for additional 
information.

3.5.1 Wingwall Detail Sheet 
Checklist

 Fill in the title bar information.

 Fill in the Initials Table.

 Attach the wingwall detail drawings as references 
to the Sheet model.

 Label and dimension the details in the Sheet 
model.

 Place Notes and data tables in an open area of the 
Sheet model.

3.5.2 Reference Files

The following file(s) should be referenced into

each Wingwall Detail Sheet.

Using Saved Views of the drawings in the CDOT 
Default model will make it easier to attach those 
drawings as reference files.

File Name Location

JPC#BRDG_Model JPC#\Bridge\Drawings\R
eference_Files
Colorado Department of Transportation  3-51
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CADD Manual Section 3: Plan Production
Chapter 3: Bridge Sheets
3.6 Deck Elevations Sheet

The deck elevation sheet contains the data created by 
the Bridge Geometry program. The output from the 
Bridge Geometry program is typically processed 
through the Program File Editor or other text editor to 
clean up the Bridge Geometry output file.

See Bridge Detailing Manual for additional 
information.

3.6.1 Plan Sheet Checklist

 Fill in the title bar information

 Fill in the Initials Table

 Import the modified text file

3.6.2 Importing Text

To import text into MicroStation:

 Set the desired Text Style. This can be done from 
the Place Text or Change Text Attributes tool set-
tings box.

 Select File > Import > Text from the MicroStation 
menu bar.

 Place the text in the desired location.

All of the text in the file is placed as a single 
graphic element. If the text needs to be broken up 
into smaller parts, this can be done by either 
copying and editing the text file or copying and 
editing the text after it is placed into the drawing.
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Chapter 4 - Hydraulic Sheets

4.1 Drainage Basin Plan 
Sheet

The Drainage Basin Plan sheet provides information 
on how storm water moves through the drainage 
system in the project area.

4.1.1 Drainage Basin Plan 
Sheet Checklist

 Fill in title block information.

 Label Matchlines with the station number as 
needed at each end of the sheet.

 Place the North Arrow and Bar Scale in an open 
area of the sheet, preferably on a corner.

 Place the Call811-Stamp cell in the upper left 
corner of the sheet.

 Label horizontal alignments.

 Label right-of-way lines.

 Label the streets and roads.

 Label all existing and proposed drainage struc-
tures.

4.1.2 Reference Files

The following file(s) should be referenced into 
each Plan Sheet.

File Name Location

JPC#HYDR_Model JPC#\Hydraulics\Drawing
s\Reference_Files

JPC#DES_Model JPC#\Design\Drawings\R
eference_Files

JPC#SURV_Topo#
#Scale##

JPC#\ROW_Survey\Draw
ings\Reference_Files
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CADD Manual Section 3: Plan Production
Chapter 4: Hydraulic Sheets
4.2 Geometry Plan Sheet

The geometry plan sheet contains horizontal 
alignment data used to layout the storm water 
drainage system.

4.2.1 Geometry Plan Sheet 
Checklist

 Fill in title block information.

 Label Matchlines with the station number as 
needed at each end of the sheet.

 Place the North Arrow and Bar Scale in an open 
area of the sheet, preferably on a corner.

 Label the streets and roads.

 Label alignments with name, bearing, and curve 
number.

4.2.2 Reference Files

The following file(s) should be referenced into 
each Hydraulics Geometry Plan Sheet.

File Name Location

JPC#HYDR_Model JPC#\Hydraulics\Drawing
s\Reference_Files

JPC#SURV_Topo#
#Scale##

JPC#\ROW_Survey\Draw
ings\Reference_Files
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CADD Manual Section 3: Plan Production
Chapter 4: Hydraulic Sheets
4.3 Coordinate Geometry 
Sheet

The Coordinate Geometry sheet describes the data 
displayed on the Geometry Plan sheet in a textual 
format.

The data for this sheet is generated from the InRoads 
Geometry report and saved as an ASCII text file. This 
file is imported for the sheet contents.

4.3.1 Coordinate Geometry  
Sheet Checklist

 Fill in the title bar information.

 Import the modified text file.

 Create the linework for the data tables.

 Add headings to the table for each curve.

 Move the text into the proper cell of the table.

4.3.2 Importing Text

To import text into MicroStation:

 Set the desired Text Style. This can be done from 
the Place Text or Change Text Attributes tool set-
tings box.

 Select File > Import > Text from the MicroStation 
menu bar.

All of the text in the file is placed as a single 
graphic element. If the text needs to be broken up 
into smaller parts, this can be done by either 
copying and editing the text file or copying and 
editing the text after it is placed into the drawing.
Colorado Department of Transportation  3-59



3-60
C

o
lorad

o D
epa

rtm
en

t of T
ransp

orta
tion

S
ection 3: P

lan P
rodu

ctio
n

C
A

D
D

 M
anu

al
C

ha
pte

r 4
: H

ydrau
lic S

heets



CADD Manual Section 3: Plan Production
Chapter 4: Hydraulic Sheets
4.4 Drainage Plan

The Hydraulic Drainage Plan sheet identifies the 
location of hydraulic items in a plan view.

4.4.1 Drainage Plan Sheet 
Checklist

 Fill in the required title block data.

 Place the north arrow and bar scale in an open 
area, preferably in a corner.

 Place and annotate matchlines at each end of the 
sheet as needed.

 Place Sheet_Call811-Stamp cell in the upper left 
corner of the plan.

 Label streets and roads.

 Label horizontal alignments displayed.

 Add construction/removal notes for hydraulic 
items as needed.

4.4.2 Reference Files

The following file(s) should be referenced into 
each Hydraulic Drainage Plan Sheet.

File Name Location

JPC#HYDR_Model JPC#\Hydraulics\ 
Drawings\Reference_ 
Files

JPC#DES_Model JPC#\Design\Drawings\R
eference_Files

JPC#SURV_Topo#
#Scale##

JPC#\ROW_Survey\ 
Drawings\Reference_ 
Files

JPC#SURV_Topo 
Contour##Scale##

JPC#\ROW_Survey\ 
Drawings\Reference_ 
Files
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CADD Manual Section 3: Plan Production
Chapter 4: Hydraulic Sheets
4.5 Profile Sheet

The Hydraulics Profile sheet contains a longitudinal 
section (a profile) of the storm water system. 

4.5.1 Profile Sheet Checklist

 Label each drainage structure shown in the pro-
file. For linear items (like pipes and box culverts) 
include the Type, Length, Grade, and Rate of 
Flow. For vertical features (like manholes and 
inlets) include Type, Location, Rim/Grate eleva-
tion, and Height.

 Label the hydraulic grade line(s) shown.

 Label existing and proposed ground lines.

 Draw and label matchlines at each end of the pro-
file as needed.

 Label crossing utilities and drainage structures.

4.5.2 Reference Files

The following file(s) should be referenced into

each Hydraulics Profile Sheet.

File Name Location

JPC#HYDR_Prof JPC#\Hydraulics\Drawing
s\ Reference_Files
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CADD Manual Section 3: Plan Production
Chapter 4: Hydraulic Sheets
4.6 Structure Quantities Sheet

The Structure Quantities contains a listing of the type, 
location, and amount of material used on the project 
in a tabular form such as inlets, manholes and other 
drainage structures.  Quantities of pipe will also be 
listed.

4.6.1 Structure Quantities  
Sheet Checklist

 Fill out the sheet border information

 Attach project specific Tabulation of Drainage 
Excel worksheet.

4.6.2 Linking Microsoft Excel 
Files into MicroStation

The Hydraulics Structure Quantities drawing uses an 
Excel document to display the project structure 
quantities.

After creating the drawing file, link the Excel 
worksheet by taking the following steps:

 Highlight the area of the document to be linked 
and copy it to the clipboard

 In MicroStation select Edit>Paste Special

 In the “Paste Special” dialog box choose “Linked 
Microsoft Office Excel Worksheet”

 In the “Paste OLE” dialog box. Change the “Paste 
as” to “Link”, the “Method” to “By Corners”. 
Then tentative and select the guide line in the 
drawing file to match the .07” ENG-100 Text 
Style.

The link will display with hatching which indicates 
that the Excel file containing the linked data is 
currently open. If you close out of your Excel file, the 
hatching will go away.

4.6.3 Updating Linking 
Microsoft Excel Files

Linked Excel documents update automatically when 
the MicroStation file is opened or when you close out 
of Excel after editing.

For more information on linking Microsoft Excel files 
review this workflow, CDOT Linking Excel 
Documents to MicroStation

MicroStation Placement Methods:

Linked Microsoft Office Excel Worksheet 
(Preferred) - Requires a saved Excel file and can be 
edited by opening the document in Excel or double 
clicking the document in MicroStation. This 
method will automatically update MicroStation 
when opened or after editing.

Embedded Microsoft Office Excel Worksheet- The 
document is placed directly into MicroStation. 
Double click the document in MicroStation to edit 
in Excel as a temporary document.

Picture of Microsoft Office Excel Worksheet - 
Static graphic of the document. This method can 
not be edited or updated.
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Chapter 5 - Landscape and Environmental 
Sheets

5.1 Project Disturbance Area 
Map Sheet

Project Area Disturbance Area Map Sheet identifies 
areas of the project construction site where 
contamination of storm water can occur.

5.1.1 Project Disturbance 
Area Map Sheet 
Checklist

 Fill in the title block information.

 Place the North Arrow and Bar scale in an open 
area, preferably in a corner.

 Label the streets and roads in the project area.

 Label named drainage courses.

 Identify disturbance areas with a note describing 
the type of construction that will occur in that 
area.

 Identify the outflows of drainage systems.

5.1.2 Reference Files

The following file(s) should be referenced into 
each Project Disturbance Area Map  Sheet.

File Name Location

JPC#DES_Model JPC#\Design\Drawings\R
eference_Files

JPC#HYDR_Model JPC#\Hydraulics\Drawing
s\Reference_Files

JPC#LAND_ENVI_
Model

JPC#\Landscape_Enviro
nmental\Drawings\Refere
nce_Files

JPC#SURV_Topo#
#Scale##

JPC#\ROW_Survey\Draw
ings\Reference_Files
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CADD Manual Section 3: Plan Production
Chapter 5: Landscape and Environmental Sheets
5.2 Erosion Control Plan 
Sheet

The Erosion Control Plan sheet identifies the methods 
and materials used for erosion control in and around 
the project site. 

5.2.1 Erosion Control Plan 
Sheet Checklist

 Fill in title block information.

 Draw and label matchlines at the beginning and 
end of each sheet as needed.

 Place Sheet_Call811-Stamp cell in the upper left 
corner of the plan.

 Place the North Arrow and Bar Scale cells in an 
open area, preferably in a corner.

 Label all streets and roads.

 Label alignments and right-of-way lines.

 Include a legend identifying the different erosion 
control elements used in the plan. This should be 
placed n an open area, preferably in a corner.

 Include general erosion control notes. These 
should be placed in an open area, preferably in a 
corner.

5.2.2 Reference Files

The following file(s) should be referenced into 
each Erosion Control Plan Sheet.

File Name Location

JPC#LAND_ENVI_
Model

JPC#\Landscape_Enviro
nmental\Drawings\ 
Reference_Files

JPC#DES_Model JPC#\Design\Drawings\ 
Reference_Files

JPC#BRDG_Model JPC#\Bridge\Drawings\ 
Reference_Files

JPC#HYDR_Model JPC#\Hydraulics\Drawing
s\Reference_Files

JPC#SURV_Topo#
#Scale##

JPC#\ROW_Survey\Draw
ings\Reference_Files

JPC#TRAF_Model JPC#\Traffic_ITS\Drawing
s\Reference_Files

JPC#UTIL_Model JPC#\Utilities\Drawings\R
eference_Files

File Name Location
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CADD Manual Section 3: Plan Production
Chapter 5: Landscape and Environmental Sheets
5.3 Landscape Demo Plans 
Key Map Sheet

This sheet shows the location and identifies each 
Landscape Demo Plan sheet included in the plan set. 

5.3.1 Landscape Demo Plans 
Key Map Sheet Checklist

 Fill in the title block information.

 Place Sheet_Call811-Stamp cell in the upper left 
corner of the plan.

 Place the North Arrow and Bar Scale cells in an 
open area, preferably in a corner.

5.3.2 Reference Files

The following file(s) should be referenced into 
each Landscape Demo Plans Key Map Sheet.

File Name Location

JPC#LAND_ENVI_
Model

JPC#\Landscape_Enviro
nmental\Drawings\Refere
nce_Files

JPC#DES_Model JPC#\Design\Drawings\R
eference_Files

JPC#SURV_Topo 
Contour##Scale##

JPC#\ROW_Survey\Draw
ings\Reference_Files
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CADD Manual Section 3: Plan Production
Chapter 5: Landscape and Environmental Sheets
5.4 Landscape Demo Plan 
Sheet

The Landscape Demo Plan contains location and 
other detailed information about the removal and 
resetting of Landscape and Environmental materials.

5.4.1 Landscape Demo Plan 
Sheet Checklist

 Fill in title block information.

 Draw and label matchlines at the beginning and 
end of each sheet as needed.

 Place Sheet_Call811-Stamp cell in the upper left 
corner of the plan.

 Place the North Arrow and Bar Scale cells in an 
open area, preferably in a corner.

 Label all streets and roads.

 Label alignments and right-of-way lines.

 Place notes defining items of work. The note 
should describe the type and quantity of work.

5.4.2 Reference Files

The following file(s) should be referenced into 
each Landscape Demo Plan Sheet.
.

File Name Location

JPC#LAND_ENVI_
Model

JPC#\Landscape_Enviro
nmental\Drawings\Refere
nce_Files

JPC#DES_Model JPC#\Design\Drawings\R
eference_Files

JPC#SURV_Topo#
#Scale##

JPC#\ROW_Survey\Draw
ings\Reference_Files
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CADD Manual Section 3: Plan Production
Chapter 5: Landscape and Environmental Sheets
5.5 Landscape Planting Plans 
Key Map Sheet

This sheet shows the location and identifies each 
Landscape Planting Plan sheet included in the plan 
set. 

5.5.1 Landscape Planting 
Plans Key Map Sheet 
Checklist

 Fill in the title block information.

 Place Sheet_Call811-Stamp cell in the upper left 
corner of the plan.

 Place the North Arrow and Bar Scale cells in an 
open area, preferably in a corner.

 Place general notes in an open area, preferably in 
a corner.

5.5.2 Reference Files

The following file(s) should be referenced into 
each Landscape Planting Plans Key Map Sheet.
.

File Name Location

JPC#LAND_ENVI_
Model

JPC#\Landscape_Enviro
nmental\Drawings\Refere
nce_Files

JPC#DES_Model JPC#\Design\Drawings\R
eference_Files

JPC#SURV_Topo 
Contour##Scale##

JPC#\ROW_Survey\Draw
ings\Reference_Files
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CADD Manual Section 3: Plan Production
Chapter 5: Landscape and Environmental Sheets
5.6 Landscape Planting Plan 
Sheet

The Landscape Planting Plan contains location and 
other detailed information about the Landscape and 
Environmental materials used on the project.

5.6.1 Landscape Planting Plan 
Sheet Checklist

 Fill in title block information.

 Draw and label matchlines at the beginning and 
end of each sheet as needed.

 Place Sheet_Call811-Stamp cell in the upper left 
corner of the plan.

 Place the North Arrow and Bar Scale cells in an 
open area, preferably in a corner.

 Label all streets and roads.

 Label alignments and right-of-way lines.

 Place notes defining items of work. The note 
should describe the type and quantity of work.

 Place a legend describing patterns used to identify 
areas of work.

5.6.2 Reference Files

The following file(s) should be referenced into 
each Landscape Planting Plan Sheet.
.

File Name Location

JPC#LAND_ENVI_
Model

JPC#\Landscape_Enviro
nmental\Drawings\Refere
nce_Files

JPC#DES_Model JPC#\Design\Drawings\R
eference_Files

JPC#SURV_Topo#
#Scale##

JPC#\ROW_Survey\Draw
ings\Reference_Files
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Chapter 6 - Geology Sheet

6.1 Engineering Geology

The geology sheet contains a boring location plan, 
boring logs, and test results of the geotechnical data 
for the project.

This sheet or set of sheets is typically including the 
bridge or wall subset but is produced and provided 
by the geotechnical design unit.

6.1.1 Engineering Geology 
Sheet Checklist

 Fill in the title block data.

 Label all alignments shown in the plan.

 Label all structures shown in the plan.

 Place the boring log graph below the plan.

 Create a table for the Summary Of Test Results.

 Place the Boring log legend and Type Of Mate-
rial legend under the boring log graph.

6.1.2 Reference Files

The following file(s) should be referenced into

each Geology Sheet.

File Name Location

JPC#GEO_Model JPC#\Materials_ 
Geotechnical\Drawings\ 
Reference_Files

JPC#BRDG_Model JPC#\Bridge\Drawings\ 
Reference_Files
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Chapter 7 - Right of Way Sheets

7.1 Tabulation of Properties 
Sheet

The ROW Tabulation of Properties sheet contains a 
list of properties in the project area, their owners and 
the owner’s address, and information about the size 
and location of the property.

7.1.1 Tabulation of Properties 
Sheet Checklist

 Fill out the sheet border information.

 Attach project specific Tabulation of Properties 
Excel worksheet.

7.1.2 Linking Microsoft Excel 
Files into MicroStation

The ROW Tabulation of Properties drawing uses an 
Excel document to display the property ownership 
data.

After creating the drawing file, link the Excel 
worksheet by taking the following steps:

 Highlight the area of the document to be linked 
and copy it to the clipboard

 In MicroStation select Edit>Paste Special

 In the “Paste Special” dialog box choose “Linked 
Microsoft Office Excel Worksheet”.

 In the “Paste OLE” dialog box. Change the 
“Paste as” to “Link”, the “Method” to “By Cor-
ners”. Then tentative and select the guide line in 
the drawing file to match the .07” ENG-100 Text 
Style.

The link will display with hatching which indicates 
that the Excel file containing the linked data is 
currently open. If you close out of your Excel file, 
the hatching will go away.

7.1.3 Updating Linking 
Microsoft Excel Files

Linked Excel documents update automatically when 
the MicroStation file is opened or when you close out 
of Excel after editing.

For more information on linking Microsoft Excel 
files review this workflow, CDOT Linking Excel 
Documents to MicroStation

MicroStation Placement Methods:

Linked Microsoft Office Excel Worksheet 
(Preferred) - Requires a saved Excel file and can be 
edited by opening the document in Excel or double 
clicking the document in MicroStation. This 
method will automatically update MicroStation 
when opened or after editing.

Embedded Microsoft Office Excel Worksheet- The 
document is placed directly into MicroStation. 
Double click the document in MicroStation to edit 
in Excel as a temporary document.

Picture of Microsoft Office Excel Worksheet - 
Static graphic of the document. This method can 
not be edited or updated.
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CADD Manual Section 3: Plan Production
Chapter 7: Right of Way Sheets
7.2 Project Control Diagram 
Sheet (PCD)

There are two types of project control diagram sheet; 
Coordinate Tables Sheet and Plan Sheet. The 
Coordinate Tables sheet contains right of way point 
data in tabular format. The Plan Sheet contains the 
same data shown graphically.

7.2.1 Coordinate Tables Sheet 
Checklist

 Fill in the title block information.

 Attach project specific Coordinate Table Excel 
worksheet.

7.2.2 Linking Microsoft Excel 
Files into MicroStation

The ROW Coordinate Tables drawing uses an Excel 
document to display display important information 
regarding the right of way point data.

After creating the drawing file, link the Excel 
worksheet by taking the following steps:

 Highlight the area of the document to be linked 
and copy it to the clipboard

 In MicroStation select Edit>Paste Special

 In the “Paste Special” dialog box choose “Linked 
Microsoft Office Excel Worksheet”

 In the “Paste OLE” dialog box. Change the “Paste 
as” to “Link”, the “Method” to “By Corners”. 
Then tentative and select the guide line in the 
drawing file to match the .07” ENG-100 Text 
Style.

The link will display with hatching which indicates 
that the Excel file containing the linked data is 
currently open. If you close out of your Excel file, the 
hatching will go away.

7.2.3 Updating Linking 
Microsoft Excel Files

Linked Excel documents update automatically when 
the MicroStation file is opened or when you close out 
of Excel after editing.

For more information on linking Microsoft Excel files 
review this workflow, CDOT Linking Excel 
Documents to MicroStation

7.2.4 Plan Sheet Checklist

 Fill in the title block information.

 Label the nearest town at each end of the project 
road.

 Label data points with Point Name, Northing, 
Easting, and Elevation.

7.2.5 Reference Files

The following file(s) should be referenced into

each ROW Project Control Diagram Sheet.

MicroStation Placement Methods:

Linked Microsoft Office Excel Worksheet 
(Preferred) - Requires a saved Excel file and can be 
edited by opening the document in Excel or double 
clicking the document in MicroStation. This 
method will automatically update MicroStation 
when opened or after editing.

Embedded Microsoft Office Excel Worksheet- The 
document is placed directly into MicroStation. 
Double click the document in MicroStation to edit 
in Excel as a temporary document.

Picture of Microsoft Office Excel Worksheet - 
Static graphic of the document. This method can 
not be edited or updated.

File Name Location

JPC#DES_Model JPC#\Design\Drawings\R
eference_Files

JPC#SURV_Topo#
#Scale##

JPC#\ROW_Survey\Draw
ings\Reference_Files
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Section 3: Plan Production CADD Manual
Chapter 7: Right of Way Sheets
7.3 Land Survey Control 
Diagram Sheet (LSCD)

There are two types of ROW Land Survey Control 
Diagram sheet; the Monument Coordinate Tables 
Sheet and Plan Sheets. The Monument Coordinate 
Tables sheet contains right of way monument point 
data in tabular format. The Plan Sheet contains the 
same data shown graphically.

7.3.1 Coordinate Tables Sheet 
Checklist

 Fill in the title block information.

 Attach the project specific Coordinate Table 
Excel worksheet.

 Place a monument cell that matches the data in 
the table to the left of that table.

7.3.2 Linking Microsoft Excel 
Files into MicroStation

The ROW Land Survey Control Diagram Monument 
Coordinate Tables drawing uses an Excel document 
to display the important information regarding the 
right of way monument point data.

After creating the drawing file, link the Excel 
worksheet by taking the following steps:

 Highlight the area of the document to be linked 
and copy it to the clipboard.

 In MicroStation select Edit>Paste Special.

 In the “Paste Special” dialog box choose “Linked 
Microsoft Office Excel Worksheet”.

 In the “Paste OLE” dialog box. Change the “Paste 
as” to “Link”, the “Method” to “By Corners”. 
Then tentative and select the guide line in the 
drawing file to match the .07” ENG-100 Text 
Style.

The link will display with hatching which indicates 
that the Excel file containing the linked data is 
currently open. If you close out of your Excel file, the 
hatching will go away.

7.3.3 Updating Linking 
Microsoft Excel Files

Linked Excel documents update automatically when 
the MicroStation file is opened or when you close out 
of Excel after editing.

For more information on linking Microsoft Excel files 
review this workflow, CDOT Linking Excel 
Documents to MicroStation

7.3.4 Plan Sheet Checklist

 Fill in the title block information.

 Label each point with the appropriate cell. Edit 
the cell so that its number matches the point’s 
number.

 Label all Sections, Townships, and Ranges.

 Label all Quarter Sections.

7.3.5 Reference Files

The following file(s) should be referenced into 
each ROW Land Survey Control Diagram Sheet.

MicroStation Placement Methods:

Linked Microsoft Office Excel Worksheet 
(Preferred) - Requires a saved Excel file and can be 
edited by opening the document in Excel or double 
clicking the document in MicroStation. This 
method will automatically update MicroStation 
when opened or after editing.

Embedded Microsoft Office Excel Worksheet- The 
document is placed directly into MicroStation. 
Double click the document in MicroStation to edit 
in Excel as a temporary document.

Picture of Microsoft Office Excel Worksheet - 
Static graphic of the document. This method can 
not be edited or updated. File Name Location

JPC#DES_Model JPC#\Design\Drawings\R
eference_Files
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CADD Manual Section 3: Plan Production
Chapter 7: Right of Way Sheets
7.4 Monumentation Sheet

The Monumentation Sheets lists the Point Number, 
coordinates, and description of each monument on the 
project.

7.4.1 Monumentation Sheet 
Checklist

 Fill out the sheet border information.

 Attach project specific Tabulation of 
ROW_TabMon Excel worksheets.

 Fill out the Quantity of Monuments To Be Set 
table.

 Add General Notes as needed. These usually go 
in the center bottom of the sheet.

 Edit the Surveyor’s Statement to include the cor-
rect name.

 Add legal notices as needed.

7.4.2 Linking Microsoft Excel 
Files into MicroStation

The Monumentation drawing uses an Excel document 
to display important information about each 
monument on the project.

After creating the drawing file, link the Excel 
worksheet by taking the following steps:

 Highlight the area of the document to be linked 
and copy it to the clipboard.

 In MicroStation select Edit>Paste Special.

 In the “Paste Special” dialog box choose “Linked 
Microsoft Office Excel Worksheet”.

 In the “Paste OLE” dialog box. Change the “Paste 
as” to “Link”, the “Method” to “By Corners”. 
Then tentative and select the guide line in the 
drawing file to match the .07” ENG-100 Text 
Style.

The link will display with hatching which indicates 
that the Excel file containing the linked data is 
currently open. If you close out of your Excel file, the 
hatching will go away.

7.4.3 Updating Linking 
Microsoft Excel Files

Linked Excel documents update automatically when 
the MicroStation file is opened or when you close out 
of Excel after editing.

For more information on linking Microsoft Excel files 
review this workflow, CDOT Linking Excel 
Documents to MicroStation

MicroStation Placement Methods:

Linked Microsoft Office Excel Worksheet 
(Preferred) - Requires a saved Excel file and can be 
edited by opening the document in Excel or double 
clicking the document in MicroStation. This 
method will automatically update MicroStation 
when opened or after editing.

Embedded Microsoft Office Excel Worksheet- The 
document is placed directly into MicroStation. 
Double click the document in MicroStation to edit 
in Excel as a temporary document.

Picture of Microsoft Office Excel Worksheet - 
Static graphic of the document. This method can 
not be edited or updated.
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CADD Manual Section 3: Plan Production
Chapter 7: Right of Way Sheets
7.5 Plan Sheet

The Right of Way Plan Sheet contains data on right of 
way takes whether they are permanent or temporary 
easements in a graphical and tabular format. 

7.5.1 Plan Sheet Checklist

 Fill in the title block.

  Include street names on mainline and all cross 
streets.

 Label all Sections, Townships, and Ranges that 
appear on the sheet.

 Label property owners within the confines of 
their own parcel.

 Include a table of property owners from whom 
parcels are obtained. This will include the symbol 
that contains their property call out.

 Include curve data. Place the symbol for each 
curve next to its corresponding data.

 Include a Line Table and a Point of Beginning Tie 
Chart.

7.5.2 How To Call Out Items

 A station & offset callout should be provided at 
the beginning and ending of each item and at 
match lines. Pavement transitions may be called 
out where feasible.

 Call out items to the nearest 0.01 of a foot.

7.5.3 Reference Files

The following file(s) should be referenced into 
each ROW Plan Sheet.

File Name Location

JPC#DES_Model JPC#\Design\Drawings\R
eference_Files

JPC#ROW_Model JPC#\ROW_Survey\Draw
ings\Reference_Files

JPC#SURV_Topo#
#Scale##

JPC#\ROW_Survey\Draw
ings\Reference_Files
Colorado Department of Transportation  3-91
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CADD Manual Section 3: Plan Production
Chapter 7: Right of Way Sheets
7.6 Ownership Map Sheet

The Right of Way Ownership Map sheet depicts the 
property boundaries in a shaded area map with 
corresponding ownership data.

7.6.1 Ownership Map Sheet 
Checklist

 Fill in the title block data.

 Place the Bar Scale in an open area near the map.

 Label Sections, Townships, and Ranges on the 
map.

 Place the owner’s number bubble in or pointing to 
the appropriate parcel on the map.

 Place owner’s names and addresses in columns in 
an open area.

 Place the owner’s number bubble next to the 
appropriate name.

7.6.2 Reference Files

The following file(s) should be referenced into

each  ROW Ownership Map Sheet.

File Name Location

JPC#ROW_Model JPC#\ROW_Survey\Draw
ings\Reference_Files

JPC#ROW_Model_
Shaded-Parcels

JPC#\ROW_Survey\Draw
ings\Reference_Files

JPC#DES_Model JPC#\Design\Drawings\R
eference_Files

JPC#SURV_Topo#
#Scale##

JPC#\ROW_Survey\Draw
ings\Reference_Files
Colorado Department of Transportation  3-93
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Chapter 8 - Traffic Sheets

8.1 ITS Sheets

ITS sheets contain Detail, Plan, and Tabulation 
sheets that are used to describe the placement, 
installation, and quantities for traffic control devices.

There are three basic types of ITS sheet; detail 
sheets, plan sheets, and tabulation sheets. Details are 
concerned with the installation of the devices, plan 
sheets identify the location of the traffic control 
devices and tabulation sheets contain quantity data.

8.1.1 Detail Sheet Checklist

 Fill in the title block information.

 Place a title for each detail shown.

 Dimension each detail.

 Add general notes as needed.

8.1.2 Plan Sheet Checklist

 Fill in the title block information.

 Place north arrow and bar scale in an open area, 
preferably in a corner.

  Include street names on mainline and all cross 
streets.

 Identify installations by type of equipment used.

 Identify installations that have detail drawings 
included in the plan set.

8.1.3 Tabulation Sheets 
Checklist

 Fill in the title block information.

 Create a table for the pay items

 Add general notes as needed. These should be 
placed at the bottom of the sheet.

Pay item tables can be created in Excel and linked 
into the MicroStation sheet. For more information 
on linking Microsoft Excel files review this 
workflow, CDOT Linking Excel Documents to 
MicroStation.
Colorado Department of Transportation  3-95
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Section 3: Plan Production CADD Manual
Chapter 8: Traffic Sheets
8.2 Tabulation Sheets

Traffic tabulation sheets summarize a list of traffic 
items used on the project. These include engineering 
items, signing items, pavement markings, and 
signaling devices. Some installation details can also 
be included.

8.2.1 Traffic Tabulation Sheet 
Checklist

 Fill in the title block information.

 Create a table for the items to be tabulated.

 Place notes in an open area.

  Details that are drawn at true scale (1:1 scale) 
can be dimensioned using the MicroStation 
dimensioning tools. For “not to scale” details, 
dimensions must be constructed manually.

Pay item tables can be created in Excel and linked 
into the MicroStation sheet. For more information 
on linking Microsoft Excel files review this 
workflow, CDOT Linking Excel Documents to 
MicroStation.

Drawing at full scale makes dimensioning easier 
and helps keep dimensioning accurate.
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Section 3: Plan Production CADD Manual
Chapter 8: Traffic Sheets
8.3 Signing and Striping 
Sheets

The traffic signing and striping sheets provides 
information on the location and type of signing and 
pavement marking placement, replacement, and 
removal. The sheets can also include installation 
details as needed.

8.3.1 Existing Signing Keymap 
Sheet Checklist

 Fill in the title block information.

 Place a north arrow in an open area, preferably in 
a corner.

 Lay out the sheet blocks and identify each with 
the appropriate sheet number.

8.3.2 Existing Signing Sheet 
Checklist

 Fill in the title block information.

 Place a north arrow in an open area, preferably in 
a corner.

 Label street and road names.

8.3.3 Proposed Final Signing 
& Striping Plan Keymap 
Sheet Checklist

 Fill in the title block information.

 Place a north arrow in an open area, preferably in 
a corner.

 Lay out the sheet blocks and identify each with 
the appropriate sheet number.

8.3.4 Proposed Final Signing 
& Striping Sheet 
Checklist

 Fill in the title block information.

 Place a north arrow in an open area, preferably in 
a corner.

 Label street and road names.

8.3.5 Reference Files

The following file(s) should be referenced into 
each Traffic Signing and Striping Sheet.
.

File Name Location

JPC#TRAF_Model_
Signing-Striping

JPC#\Traffic_ITS\Drawing
s\Reference_Files
3-106 Colorado Department of Transportation
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Section 3: Plan Production CADD Manual
Chapter 8: Traffic Sheets
8.4 Signal Plan Sheets

The Traffic Signal Plan sheets contain data on the 
location, installation, and quantity of traffic control 
devices. This data is presented in graphic and tabular 
formats.

8.4.1 Plan Sheet Checklist

 Fill in the required title block information.

 Place the SHEET_Call811-Stamp cell in an open 
area, preferably a corner.

 Add construction/removal notes to the plan por-
tion of the sheet.

 Place small details (like Signal Faces) in an open 
area. These can be placed in the section of the 
sheet used for tabulations and other notes.

 Place Signal Information notes in the same part of 
the sheet with the tabulation material.

 Place a legend identifying traffic control device 
symbols used in the plan. This can also be placed 
in the section of the sheet used for tabulations and 
other notes.

 Place a table of Signal Item quantities in an open 
area.

8.4.2 Reference Files

The following file(s) should be referenced into 
each Traffic Signal Plan Sheet.

File Name Location

JPC#TRAF_Model_
Signing-Striping

JPC#\Traffic_ITS\Drawing
s\Reference_Files

JPC#TRAF_Model_
Signal-Utilities

JPC#\Traffic_ITS\Drawing
s\Reference_Files

JPC#DES_Model JPC#\Design\Drawings\R
eference_Files
3-112 Colorado Department of Transportation
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Section 3: Plan Production CADD Manual
Chapter 8: Traffic Sheets
8.5 Detour Sheets

Traffic detour plans are used to describe a detour 
route, identify signage type and location,

8.5.1 Ramp Detour Sheet 
Checklist

 Fill in the title block information.

 Provide a written description of the detour. 
Include the Ramp name where traffic is routed to, 
which roads will have signage, and VMS mes-
sages (if available).

 Show examples of typical signing for each detour.

8.5.2 Detour Route Sheet 
Checklist

 Fill in the title block information.

8.5.3 Detour Plan Sheet 
Checklist

 Fill in the title block information.

 Place a north arrow in an open area, preferably in 
a corner.

 Place Sheet_Call811-Stamp cell in the upper left 
corner of the plan.

 Place notes in an open area.

8.5.4 Reference Files

The following file(s) should be referenced into 
each Traffic Detour Plan Sheet
.

File Name Location

JPC#TRAF_Model_
Detour-Plan

JPC#\Traffic_ITS\Drawing
s\Reference_Files
3-114 Colorado Department of Transportation
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Chapter 9 - Utility Sheets

9.1 Lighting Plans

The Utilities Lighting Plan defines the location and 
type of utility lighting items used on the project. 

9.1.1 Plan Sheet Checklist

 Fill in the title block information.

 Place a north arrow in an open area, preferably in 
a corner.

 Place Sheet_Call811-Stamp cell in the upper left 
corner of the plan.

 Draw and label matchlines at the beginning and 
end of each sheet as needed.

 Clearly label horizontal alignments. 

 Include street names on mainline and all cross 
streets.

 Label all structures. This includes bridges, box 
culverts, and retaining walls. 

 Place a Legend and any General and Working 
Notes on the first Lighting Plan Sheet in the set.

9.1.2 Reference Files

The following file(s) should be referenced into 
each Utility Lighting Plan Sheet.

File Name Location

JPC#UTIL_Model JPC#\Utilities\Drawings\ 
Reference_Files

JPC#BRDG_Model JPC#\Bridge\Drawings\ 
Reference_Files

JPC#DES_Model JPC#\Design\Drawings\ 
Reference_Files

JPC#HYDR_Model JPC#\Hydraulics\Drawing
s\Reference_Files

JPC#SURV_Topo#
#Scale##

JPC#\ROW_Survey\Draw
ings\Reference_Files
Colorado Department of Transportation  3-117
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Section 3: Plan Production CADD Manual
Chapter 9: Utility Sheets
9.2 Plan Sheet

The Utility Plan defines the location and type of 
utility items usd on the project. 

9.2.1 Plan Sheet Checklist

 Fill in the title block information.

 Place a north arrow in an open area, pref-
erably in a corner.

 Place Sheet_Call811-Stamp cell in the 
upper left corner of the plan.

 Draw and label matchlines at the begin-
ning and end of each sheet as needed.

 Clearly label horizontal alignments. 

  Include street names on mainline and all 
cross streets.

 Label all structures. This includes 
bridges, box culverts, and retaining walls. 

 Place a Legend on each Utility Plan Sheet 
in the set.

9.2.2 Reference Files

The following file(s) should be referenced into 
each Utility Plan Sheet.

File Name Location

JPC#UTIL_Model JPC#\Utilities\Drawings\R
eference_Files

JPC#DES_Model JPC#\Design\Drawings\R
eference_Files

JPC#HYDR_Model JPC#\Hydraulics\Drawing
s\Reference_Files

JPC#SURV_Topo#
#Scale##

JPC#\ROW_Survey\Draw
ings\Reference_Files
3-120 Colorado Department of Transportation
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Section 3: Plan Production CADD Manual
Chapter 9: Utility Sheets
9.3 Pothole Log Sheet

The Utilities Pothole Log sheet identifies the location 
(by coordinates) of potholes and the utility located by 
the pothole. ‘

9.3.1 Pothole Log Sheet 
Checklist

 Fill in the title block information.

 Place a north arrow in an open area, preferably in 
a corner.

 Place Sheet_Call811-Stamp cell in the upper left 
corner of the plan.

 Draw and label matchlines at the beginning and 
end of each sheet as needed.

 Clearly label horizontal alignments. 

  Include street names on mainline and all cross 
streets.

 Label all structures. This includes bridges, box 
culverts, and retaining walls.

 Place a Legend on each Utilities Pothole Log 
Sheet in the set.

 Include a table that contains the data for each pot-
hole found on the sheet. This table can be created 
in Excel and linked to the drawing file.

9.3.2 Linking Microsoft Excel 
Files into MicroStation

The Utilities Pothole Log drawing uses an Excel 
document to display  important information about the 
utilitiy potholes shown.

After creating the drawing file, link the Excel 
worksheet by taking the following steps:

 Highlight the area of the document to be linked 
and copy it to the clipboard.

 In MicroStation select Edit>Paste Special.

 In the “Paste Special” dialog box choose “Linked 
Microsoft Office Excel Worksheet”.

 In the “Paste OLE” dialog box. Change the “Paste 
as” to “Link”, the “Method” to “By Corners”. 
Then tentative and select the guide line in the 
drawing file to match the .07” ENG-100 Text 
Style.

The link will display with hatching which indicates 
that the Excel file containing the linked data is 
currently open. If you close out of your Excel file, the 
hatching will go away.

9.3.3 Updating Linking 
Microsoft Excel Files

Linked Excel documents update automatically when 
the MicroStation file is opened or when you close out 
of Excel after editing.

For more information on linking Microsoft Excel files 
review this workflow, CDOT Linking Excel 
Documents to MicroStation

MicroStation Placement Methods:

Linked Microsoft Office Excel Worksheet 
(Preferred) - Requires a saved Excel file and can be 
edited by opening the document in Excel or double 
clicking the document in MicroStation. This 
method will automatically update MicroStation 
when opened or after editing.

Embedded Microsoft Office Excel Worksheet- The 
document is placed directly into MicroStation. 
Double click the document in MicroStation to edit 
in Excel as a temporary document.

Picture of Microsoft Office Excel Worksheet - 
Static graphic of the document. This method can 
not be edited or updated.
3-122 Colorado Department of Transportation

http://www.coloradodot.info/business/designsupport/cadd/cadd-workflows/v8-xm/cdot-linking-excel-documents-to-microstation.pdf
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9.3.4 Reference Files

The following file(s) should be referenced into 
each Utilities Pothole Log Sheet.

File Name Location

JPC#UTIL_Model JPC#\Utilities\Drawings\R
eference_Files

JPC#DES_Model JPC#\Design\Drawings\R
eference_Files

JPC#HYDR_Model JPC#\Hydraulics\Drawing
s\Reference_Files

JPC#SURV_Topo#
#Scale##

JPC#\ROW_Survey\Draw
ings\Reference_Files
Colorado Department of Transportation  3-123
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